Atlas Forms - Quickstart

AWS re:Invent Workshop from MongoDB

Important: If we run out of time to complete all the tasks in this you can
g continue it later, photograph this paragraph and use

E 'jﬁ'l-l the following URL to take you to an online version of
FY 3=, . this document ( http://mdb.link/AtlasForms ) you
:' can use later. Or now if you prefer it to using this

paper copy.

This set of instructions will enable you to install and host your first end-user ready application either
using a supplied data set of another of your choice. It is followed by a brief infroduction to
customizing and managing your application.

If you do not already have one, sign up for an
account at GitHub (www.github.com) - this will
allow you to manage and edit the code for this S

project online. It takes about a minute to do erienslodgeggnail.con
and is worth it for the animation.

Create a password

Enter a username
orionslodg3

Would you like to receive product updates and
announcements via email?
Type "y" for yes or "n" for no

n



http://mdb.link/AtlasForms
http://www.github.com

In your browser open the public GitHub
repository for this project
(https://github.com/mongodb-developer/Atlas
Forms) then at the top right, select the Fork
dropdown and then Create a new fork. This
will make your own private copy of the code
linked back to the original to allow you edit to
pull and push changes from the main
repository if required.

Create a new fork
A fork is a copy of a repository. Forking a repository allows you to freely experiment with changes without
affecting the original project. View existing forks.

Owner * Repository name *

&, orionslodge~ [ [ AtlasForms J]

By default, forks are namec AtlasForms is available. ream repository. You can customize the name to
distinguish it further.

Description (optional)

Forms Based Ul for MongoDB Atlas

Copy the main branch only
Contribute back to mongodb-developerfAtiasForms by adding your own branch. Learn more.

(@ You are creating a fork in the orionslodge organization.

If you do not already have a MongoDB Cloud
account, sign up for one at
https://account.mongodb.com/account/reqist
er clicking Try Free , you do not need to
provide any payment details. Once you verify
your email for to cloud.mongodb.com and click

v D |
Sign up

See what Atlas is capable of for free

First Name*
Sign In,
Last Name*
If you are new to Atlas you will be offered the 0 ivogons - O AccessManager v Biling
choice to "Build a Database" but we are going
I Project 0 > i Atlas App Services Charts

to ignore this and go straight to creating an
application and an associated database so
instead click App Services on the second row
of the menu bar.

- MONGODB » PROJECT O
£ DEPLOYMENT

) Dotabase Database Deployments

Data Lake PREVIEW

£ DATA SERVICES

Triggers

If this is your first time using App Services you
are offered the change to "Start with an app
template”. Select Build your own App then
Next. If it's not your first time then just Create
a New App.

v

Welcome to Atlas App Services

Seamlessly connect your data to mobile apps, websites, and backend services with Atlas's fully managed App Services.

Start with an app template
Using App Sen d need to write. Get d quicker with Templates.

Q, ®

Build your own App

Set upyour own app services Mobile app using a Realm SDK to sync data to your backend

tofityour development

needs | € O 4



https://github.com/mongodb-developer/AtlasForms
https://github.com/mongodb-developer/AtlasForms
https://account.mongodb.com/account/register
https://account.mongodb.com/account/register

The next screen defines our application, it is
Important to fill this out correctly for this
workshop, do not choose your own options.
Leave the Data Source option alone.
Name the Application : AtlasForms

Ensure the deployment model is: Global .
Virginia(us-east-1) AWS

Then click Create App Service

© Link your Data Source

Template Starter Applications let you buil

Create New MO Atlas Cluster »#°

© Name your Application

This name will be used internally and can

AtlasForms

© App Deployment Model

Global « =

Id on top of data in @ MengeDB Atlas cluster.

not be changed later

Virginia (us-east-1) « AWS | Region chosen based on your cluster's region

If you see "Welcome to Application Guides"” -
Click Close Guides and any other popups.
You will then see the application console.

AtlasForms | e

Get Started With App Services | Guides |

(D
,

Requests Data Transfer

o 0.00 GB

Recently Opened

Compute Runtime

0.00 Hours

Syne Runtime
0.00 Hours

We now want to start loading in some example
data to our newly created highly available
database cluster - this takes a little while so we
will start it now. Click Atlas on the second row
of the menu bar to take us to Database Cluster
Management.

’ 83 MongoDB = 3 Access Manager »  Billing
= Project 0 - Atlas App Services
=2 Apps
| & stosome @ AtlasForms | s
NO ENVIRONMENT

Close any pop ups telling you about new
features or how MongoDB can help you and
then click the three dots shown and choose
Load Sample Dataset and confirm the

popup.

O CmEnE MONGODS > PROJECT O

Database Database Deploy

Datalake PREVIEW

[ DATASERVICES
Triggers

Data API

Data Federation

@ securiTY
Database Access.
Network Access

Advanced

NewOnAtlas 2

5013 AWS / Ireland (eu-west-1)

ments

ViewHritrng | [ wrowse Catectons | [

sssssssssss

MO Sandbox (General)  ReplicaSet-3nodes  Inactive




While our data imports we will go and create
an application for it, Click App Services on the
second row again to jump back to application
management.

Then click on the Atlas Forms application at
the bottom left. You can have multiple
applications per project so if you have used this
before you may have more than one.

O

Project 0

2 DEPLOYMENT

=

MongoDB

Access Manager ¥ Billing

Atlas App Services

We are deploying your changes

Atlas Forms can be hosted using Atlas Hosting
or you can host the content of the hosting/files
directory anywhere else, they are static HTML,

JS and CSS files.

Atlas Hosting can be enabled by anyone with a
paid cluster attached , if you want to use it with
the free-tier, you need to add a payment
method, create a 'Serverless' cluster and attach
that. Once you enable hosting you can detach
the cluster - you do not need to spend any
money on doing so but anonymous hosting is
too easy to abuse. The instructions below
assume you have attached a paid cluster (in
addition to the free cluster) to allow you fo furn
on hosting.

Now we are going to enable static hosting. This
is hosting files on Cloudflare CDN to be the
front-end of our application. Click Hosting
near the bottom of the items on the left (under
Manage). Then click Enable Hosting. Dismiss
any pop ups and you should see a web address
shown. Take a note of the URL, also note
down your Unique App Id which is the five
random characters after atlasforms in the URL.

=1 Apps

A AtlasForms

NO ENVIRONME

& DATAACCESS
Rules

Schema

App Users

Authentication
= suip
Realm SDKs

Device Sync

NT

l @ oursite s in the process of being created, which may take up to 15 minutes.

Hosting

Files  Settings
atlasforms-heixg.mongodbstitch.com /
s

O Name Last Modified

O Bindexhtml 11/18/2022 10:08:03

Now we are ready to attach our App Services
Application to our Github Repository and
import the Atlas Forms application. To do this
click Deployment (just above hosting on the
left) then click Configuration (second in list of
tabs within Deployment).

Work through the first three steps on the
page, once you complete step 1 close the
github tab that opened to let you do it. Select

Deployment

uuuuuuuuuuuuuuuuuuuuuuuuuu
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the Atlas form repo, main branch , leave the
directory as is, click save and then click
Enable Automatic Deployment. Confirm the
pop-up by clicking Enable Automatic
Deployment again.

Now when we make changes to the code in
github it will be automatically deployed to App
services and vice versa. It's important to
change the github code here first to make the
github version overwrites the defaults to return
fo your repo in github in a new tab. The URL will
be

https://github.com/YOUR USERNAME/Atla
sForms

Forms Based Ul for MongoDB Atlas

We are now going to use github.dev - version of
Visual Studio Code built intfo GitHub to edit our
application. To enable this just press the period
() key on the github page. This will open an
online IDE.

& github.dev/orionslodge/AtlasForms

EXPLORER [Preview] README.md X

- ATLASFORMS [GITHUB]

> auth

> hitp_endpoints

> sync

> triggers

@ gitignore
LICENSE

¥ ManualTestScript.md
® README.md
realm_config json

AtlasForms

Forms Based Ul for MongoDB Atlas

Introduction

Atlas forms is a Forms based, End user interface to allow users to Create, F
Fourth Generation Language (4GL) in that it abstracts away all database de
solution to building an internal GUI to interact with Data.

It differs from a 4GL in having no proprietery coding language - it si insteac
serverless function on MongoDBs Atlas Developer Data PLatform. Itis inter
designed to me modular and easily modified.

Installation

Change avbdx to your own appid throught this repo and import.

Click the Hamburger menu at the top left and
select Edit->Replace in files

¥ ManualTestScript.md
) DEANME A

File bl
Unde
Selection > Redo
View >
Cut
Go 5
Copy
Help »
Copy As
Go to Repository Paste
> sync Find
> triggers Replace
4 .gitignore
LICENSE Find in Files

Replace in Files

[Preview] README.md X

%7
.
HHZ H
viongoDB Al
>
ns based, Er
anguage (4¢
¥#F g ge (
an internal G
HF

in having ne
@¥#F  yn MongoDE
03H ular and ea

Now enter the string xxxab in the Find box and
your Unique App Id in the Replace box then
click the replace all button next to the
replace box, confirm you want to replace 6
instances in 5 files.

SEARCH U==0EZ [Preview] README.md
qvbdx Aa ab, ¥

< AtlasForms
heixg AB

6 results in 5 files - Open in editor

~ (D README.md 1
Change gwbehxheixg to your own appid th...

~ realm_config.json 1
"app_id": "atlasforms-gwbexheixg",

~ providers.json auth 2

emailConfirmationUrl": "https:/fatlasform...

resetPasswordUrl": "https://atlasforms-g...

~ config.json hosting 1

app_default_domain": "atlasforms-gvbdx...

~ appConfig.js hostingffiles 1

ATLAS_SERVICES_APPID : "atlasforms-g...

Forms Based Ul for MongoDB Atlas

Introduction

Atlas forms is a Forms based, End user interf
Fourth Generation Language (4GL) in that it
solution to building an internal GUI to interac

It differs from a 4GL in having no proprietery
serverless function on MongoDBs Atlas Deve
designed to me modular and easily modified.
Installation

Change gqvbdx to your own appid throught th



https://github.com/YOUR_USERNAME/AtlasForms
https://github.com/YOUR_USERNAME/AtlasForms

Then click the three circles on the left with
the blue dot on it, type a comment like
'Version 1' in the box then click the check
mark above. to deploy the change.

g_o

SOURCE CONTROL

| First Deploy

~ Changes

(L README.md
realm_config.json
providers.json auth
config.json hosting
appConfig.js hostingfiles

M
M
M
M
M

[Preview] README.md x
AtlasForms

Forms Based Ul for MongoDB A

Introduction

Atlas forms is a Forms based, Ei
Fourth Generation Language (41
solution to building an internal C

It differs from a 4GL in having ni
serverless function on MongoDt
designed to me modular and ea

Open the URL you noted earlier, if you get
a 'Hello World' you may need to refresh as
the site is still setting up. Add yourself as
a new user, acknowledge the
confirmation email (you can use your
phone for that) then log in tfo your own
application. All the code for this application
is in your GitHub repo and changes you
make in GitHub or the Atlas UI will reflect
as soon as you commit them.

Email:

Enter email..

Password:

Enter password..

m Reset Password

As the first user, you will be logged in as a
superuser, this will allow you to manage
users and all the rules and data sources.
We are going tfo add a data source so we
have something to work with. By default
you are seeing the user management form
but that's not interesting right now as it's
just you.

Atlas Forms  AF_Users

id Data Email

Id Type

Permissions IsSuperUser
®0,

Createdate

Id Provider Type

®0,

ddfmm/yyyy, -=i--

Createdate

o

We already loaded sample data so now we
can create a frontend to allow users to
interact with that data. Let us take a very
brief diversion to look at the data we
loaded and also to enable full text indexing
of it. From cloud.mongodb.com again click
Atlas on the 2nd row to see this view.

Browsa Colections || -




Click Browse Collections, then Click

sample_airbnb fthen ListingsAndReviews | A
- you can see the sample AirBNB rental

property data we are going to build an

INSERT D¢

listingsAndReview: .
application for, to allow you to search and S
manage this data. To enable Search - click -
'Search Indexes’ just above the sample e

document - it has a green spot on it.

This enables Atlas Search for this data Search Indexes
source, a fully managed Apache Lucene
based fuzzy Search Index (in addition to e

Database Indexes that Atlas provides) - e i s |
Click all the Green default buttons as e
they appear (approx. 5) until Atlas tells
you it is building your search index . We

are accepting the defaults for now.

Now return to your application and your i L e - o
custom application URL and add the e
sample_airbnb.listingsAndReviews data set
to our application. Choose AF_Doctypes

ArBNB sample_airbnb.listingsAndReviews [ "name?, "beds", "address.country" ]

from the dropdown at the top left then e
Enter the following in the form, use the 7 /
(+) to add a new box for each of the
ListViewFields you enter. Leave Id . e
blank. | "
Namespace:
sample_airbnb.listingsAndReviews
Title:
AirBNB
ListviewFields: (Three entries in list)
° name
e beds

e address.country

We are not going to enable relationships
between document types just now but this
is where to configure it..

Now click Create on the menu bar at the
top. You just entered your first record in
your system - this was a configuration
record but data is entered the same way.




Refresh/ the page - this is the same as
logging in again and you will now see your
new form selected.

Enter a word like "Ship"” in the text box next
to the Search button and click Search. Now
you see all properties that mention ships.

Click on one to view it. You can click Clear to
try a different search, you can also search by
filling in fields on a blank form.

Atlas Forms  AIrBNB v
Name Beds
-
Ribeira Charming Duplex 5
Horto flat with small garden 2
Ocean View Waikiki Marina w/prkg 1
Private Room in Bushwick 1
Id Listing Url
10009999 https:/fwww.airbnb.com/rooms/10009999
4
Summary

One bedroom + sofa-bed in quiet and bucolic neighbourhood right next to the Botanical Garden. Small
with shower and tub. Easy for transport with many restaurants and basic facilities in the area.

Space
Lovely one bedroom + sofa-bed in the living room, perfect for two but fits up to four comfortably. Ther
open kitchen with both 110V / 220V wall plugs and one bathroom with shower, tub and even a sauna mi

Description
One bedroom + sofa-bed in quiet and bucolic neighbourhood right next to the Botanical Garden. Small

As a Superuser you can create and edit AasForms | N - =3 ]
anything, manage users, permissions, and ame e , Adrmagoimy
dropdown lists. Let's configure a dropdown list -
Change the dropdown to AF_Picklists and
enter the following.
Database: sample_airbnb
Collection: listingsAndReviews
Fieldname: minimum_nights -
Values: 1

2 House Rules

3 Property Type Room Type Bed Type Minimum Nights

7 v

- Cancellation Policy Last Scraped Calendar Last Scraped First Review 1
Then click Create then reload the page. You w0 Gy, 0 ddmmiy , - O
will now see there is a dropdown for the R Bedrooms Beds Number OFR: 3
Minimum nights field.
Finally as a Developer you can do far more - -

Charts LA

let's look at and then run a custom serverless
function that generates picklists for us from the
data in the collection. Open your App Services
browser tab in the Atlas UI and click 'Functions’
on the left to view your Atlas (Serverless)
functions.

/18/202210:05:37




Click on the first one
(ADMIN_PicklistGenerator) , this function is
private and is never called (or callable) from the
UI although you could make it public and add
a button. Around line 117 you can see it is hard
coded to the collection we are working with - it
will compute the values needed for all picklist
fields. At the bottom of the Console, Change
User to yourself then Click Run at the bottom
of the page to run it and generate our picklists.

Now return to your Forms Application and
reload and you will see many fields like
amenities or property type have a list, and you
can edit these in the AF_Picklists Doctype.

15 return picklist(@

18- exports - async function (arg

< database
i 76 const collection

Missing semicolon.

> ran at 1668769775922
> took 821.438787ms
> logs:

MAX_PTCKLIST.

TistinasAndRevi ews

186 unique elements from 121402

> result:
true

351 fieldName

1+ async function getPicklistvalues
2 const collection - context services get tlas") . db(databaseName) . collection(collectionName
3 const SAMPLESIZE - 10000; /* Limit to not the fist 10000*
4 let picklist
S- try
6 const sample ssample: | size: SAMPLESIZE
7 const unwindArray - { Sunwind: $5{fieldName
8 const groupAll Sgroup: { _id: null, count: { $sum: 1 }, values: { SaddToSet
9
i 10 const pipeline - sample, unwindArray, groupAll
1 picklist - await collection aggregate(pipeline) . toArray
12- } catch (e
13 console.error(e
14

| Chango Usor

This is just scratching the surface of what you can do with Atlas Forms - The full manual is
available at https://mdb.link/AtlasFormsManual



https://mdb.link/AtlasFormsManual

